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1 Introduction 

Estimating erosion plays a critical role in soil and water resource conservation, sediment load 

assessment, conservation planning, design for sediment control, and prioritisation of nature-

based solutions, amongst others. Average global soil erosion has been assessed at 2.8 tons 

ha-1 y-1 (Borrelli et al., 2017). However, large spatial variation exists, and hotspots where 

erosion rates above 20 ton ha-1 y-1 are found as well. Results from this global assessment 

were based on an analysis of grids of 250x250 m but at smaller scales (fields, plots) much 

higher values have been reported in many places. 

 

The two primary types of erosion models are (i) process-based models and (ii) empirically 

based ones. Full process-based model implementations are very demanding in terms of data 

requirements and computational resources when implemented at river basin scale (Eekhout 

et al., 2018). For this reason, typically a mix of physical and empirical approaches are included 

in erosion simulation models (e.g. Hunink et al., 2015; Willemen et al., 2019). It is 

recommended that erosion model concepts need to be chosen based on data availability and 

project requirements (Alewell et al., 2019). 

 

It is well known that rainfall variability plays a dominant role in erosion processes and therefore 

most erosion models are based on dynamic hydrological models which allow simulations 

under different weather conditions. The WEAP1 model (Water Evaluation And Planning Tool), 

as developed by the Stockholm Environment Institute (SEI), is one of the more frequently used 

models for water resources planning and scenario analysis. Up to now, WEAP did not include 

a module for the estimation of erosion rates. However, for many scenario assessments, 

erosion is an important topic to be accounted for, as it influences the lifetime and performance 

of grey infrastructure, and for evaluating the effectiveness of green infrastructure solutions 

(Hunink and Droogers, 2015; Simons et al., 2017; Simons and Hunink, 2018). FutureWater 

and SEI therefore have developed a plugin for WEAP (referred to as WEP: WEAP Erosion 

Plugin) to undertake erosion assessment studies. 

 

The objective of this report is to introduce the methodological approach behind the erosion 

plugin and to provide a hands-on tutorial on using the WEAP Erosion Plugin (WEP).    

 

 

  

 
1 https://www.weap21.org/ 
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2 Erosion 

 Universal Soil Loss Equation (USLE) 

The Universal Soil Loss Equation (USLE) was developed based on empirical studies in erosion 

plots and rainfall simulator experiments. The USLE is composed of six factors to predict the 

long-term average annual soil loss (A). The empirical equation includes the rainfall erosivity 

factor (R), the soil erodibility factor (K), the topographic factors (L and S), and the cropping 

management factors (C and P). The equation takes a simple product form: 

 

A = R ∙ K ∙ L ∙ S ∙ C ∙ P 

 

where: A (Mg ha-1 yr-1) is the annual average soil erosion, R (MJ mm h-1 ha-1 yr-1) is the rainfall-

runoff erosivity factor, K (Mg h MJ-1 mm-1) is the soil erodibility factor, L (dimensionless) is the 

slope length factor, S (dimensionless) is the slope steepness factor, C (dimensionless) is the 

land cover and management factor, P (dimensionless) is the soil conservation or prevention 

practices factor.  

 

The original USLE method is based on the experimental unit plot concept. The unit plot is 

defined as the standard plot condition to determine the soil's erodibility (K). These conditions 

are when the LS factor = 1 (slope = 9% and length = 22.1 m), the plot is fallow, tillage is up 

and down the slope, and no conservation practices are applied (C and P are both 1). USLE 

and its parameters are based upon an 80-year history of erosion modelling and applications 

in over 100 countries. The origin of the USLE model was in the US to provide a management 

decision support tool and was based upon thousands of controlled studies on field plots and 

small watersheds since 1930.  

 

An implementation of the USLE where the rainfall erosivity is replaced by runoff volume 

(Modified USLE, MUSLE) resulted in a satisfying prediction of measured sediment yield 

already in the mid-seventies and early eighties (Smith, Williams, Menzel, & Coleman, 1984; 

Williams, 1975). The latter allows the equation to be applied to individual storm events. Several 

variants of the MUSLE equation exist and MUSLE was even integrated in GIS (e.g. in 

ArcMUSLE; (Zhang, Degroote, Wolter, & Sugumaran, 2009).  

 

In the SWAT model, erosion caused by rainfall and runoff is computed with the Modified 

Universal Soil Loss Equation (MUSLE) (Williams, 1975). MUSLE is a modified version of the 

Universal Soil Loss Equation (USLE) developed by Wischmeier and Smith (1965, 1978). 

USLE predicts average annual gross erosion as a function of rainfall energy. In MUSLE, the 

rainfall energy factor (R) is replaced by a runoff factor. This improves the erosion prediction, 

eliminates the need for delivery ratios, and allows the equation to be applied to individual storm 

events.  

 

This modified universal soil loss equation as used in SWAT is (Williams, 1995): 

 

sed =11.8 • (Qsurf • qpeak • areahru)0.56 • KUSLE • CUSLE • PUSLE • LSUSLE  

 

where  

sed is the sediment yield on a given day (metric tons),  
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Qsurf is the surface runoff volume (mm H20/ha),  

qpeak is the peak runoff rate (m3/s),  

areahru is the area of the hydrological response unit (HRU) (ha),  

KUSLE is the USLE soil erodibility factor (0.013 metric ton m2
 hr/(m3 -metric ton cm)),  

CUSLE is the USLE cover and management factor,  

PUSLE is the USLE support practice factor,  

LSUSLE is the USLE topographic factor.  

 

The two coefficients 11.8 and 0.56 were obtained during the original development of MUSLE 

and might be adjusted by calibration. In practice, most research assumes those coefficients 

as constants.  

 Implementation of MUSLE in WEAP Erosion Plugin (WEP) 

The WEAP Erosion Plugin (WEP) is based on the MUSLE approach as described above. WEP 

has been designed to derive the following MUSLE parameters in a simplified way: 

• R_USLE (rainfall-runoff erosivity factor) 

o Based on surface runoff as calculated by WEAP and the intensity of the 

rainfall expressed as hours in the day it rains (1-24) 

• K_USLE (soil erodibility factor): 

o Derived from the geometric mean weight diameter of soil particles 

• C_USLE (land cover and management factor) 

o User input between 0 (e.g. forest) and 1(degraded land) 

• P_USLE (soil conservation and prevention practices factor) 

o User input between 0 (e.g. full erosion control measures) and 1(no erosion 

control measures) 

• LS_USLE (slope and steepness factor) 

o Derived from the average slope in an area 

 

 Input data for the WEAP Erosion Plugin (WEP) 

WEP requires the user to enter the following four input variables (see section below for details): 

• Soil Particle Diameter 

o Geometric mean weight diameter of soil particles (mm). Values range from 

0.0001 (clay) to 2 (sand). Is used to assess the K_USLE. 

• Rain Intensity 

o Hours per day that rainfall occurs. 1 = daily rainfall falls in 1 hour (high 

intensity); 24 = daily rainfall fall during entire day (low intensity) 

• C_USLE 

o Land cover and management factor. Values can range from 1 (fallow/bare 

land) to 0.001 (forest). 

• P_USLE 

o Supporting conservation practice. Values range from 0 (very good manmade 

erosion resistance facility) to 1 (no manmade erosion resistance facility). 
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Since WEP version 2023. The following inputs are automatically estimated using Catchment 

Delineation Mode: 

• Catchment area (area of the catchment in hectares) 

o Used to upscale erosion amounts. 

• Slope (average slope in the catchment in degrees) 

o Used to assess the LS_USLE. 

 

The WEAP implementation of the MUSLE parameters are more thoroughly described in 

Chapter 2.5.  

 

 WEAP Erosion Plugin (WEP) results 

WEP provides the following results: 

• Erosion per Hectare [tons/ha] 

o The amount of erosion in tons per hectare 

 

11.8 * (Surface Runoff [mm] * Peak Runoff [mm])0.56 * KUSLE • CUSLE • PUSLE • LSUSLE 

 

where Surface Runoff [mm] is simulated by WEAP, Peak Runoff [mm] = Surface Runoff[mm] 

/ Rain Intensity[hr]. MUSLE parameters as described in 2.5.  

 

 

• Erosion Total [tons] 

o The total amount of erosion for the specific catchment in ton 

 

Erosion per Hectare [t/ha] * Area Calculated [ha]  

 

where Erosion per Hectare [t/ha] is estimated by the formula above, and Area Calculated [ha] 

is estimated automatically via Catchment Delineation Mode or added manually.  

 WEAP Erosion Plugin (WEP) parameters 

 K_USLE (soil erodibility factor) 

K_USLE factor is the soil erodibility factor which represents the susceptibility of soil to erosion 

as measured under the standard unit plot condition: 

• Clay soils are resistant to detachment and have low K values 

• Sandy soils have low runoff rates and have low K values 

• Silt loam soils are moderately susceptible to detachment produce moderate runoff 

and, have moderate K values  

• Silty soils are the most erodible of all soils. They are easily detached; tend to crust 

and produce high rates of runoff. K values are between 0.02 and 0.04 

 

In WEP the K factor is calculated based on (Renard et al., 1997) using the geometric mean 

weight diameter of soil particles (mm):  

 

K_USLE = 0.0437 • exp( -(log(Dg) + 1.6680)^2 / (2 • 0.7661^2) ) 
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where: 

Dg is the geometric mean weight diameter of soil particles (mm) 

note that the log is the log for base 10 

 

Typical values of Dg (and the associated K_USLE) are: 

Sand: 0.2 – 2.0 mm (0.0197 - 0.0016) 

Loam: 0.06 – 0.2 mm (0.0369 - 0.0197) 

Silt: 0.002 - 0.06 mm (0.0177 - 0.0369) 

Clay: 0 - 0.002 mm (0.0000 - 0.0177) 

 C_USLE is the cropping management Factor (C) 

C_USLE is a reduction factor to soil erosion vulnerability and is related to land use. C_USLE 

is the vegetation cover percentage and is defined as the ratio of soil loss from specific crops 

to the equivalent loss from tilled, bare test plots. The value of C_USLE depends on vegetation 

type, stage of growth, and cover percentage. Lots of literature exists on proposed C_USLE 

values. Some methods derive the C factor from satellite-based remote sensing data (Hunink 

et al., 2015) which allows accounting for spatial and temporal variability. Table 1 provides one 

reference that can be used in the WEAP model, but this can be adapted as desired.  

 

Table 1. Cropping management factor C_USLE. Source: (Park et al., 2007) 

Land Use Vegetation cover C_USLE 

Follow/Bare land  1.0 

Paddy field  0.34 

Upland  0.31 

Grassland 
(95 ~ 100% cover) 

Grass 
0.003 

 Weeds 0.01 

 (80% cover) 
Grass 

0.01 

 Weeds 0.04 

 (80% cover) 
Grass 

0.04 

 Weeds 0.09 

Forest (75 ~100% cover) 0.001 
 (40 ~ 75% cover) 0.002 ~ 0.004 
 (20 ~ 40% cover) 0.003 ~ 0.01 

 P_USLE is the supporting conservation practice factor 

P_USLE is the reduction factor that represents the effects of practices such as contouring, 

strip cropping, and terracing, that help prevent soil from eroding by reducing the rate of water 

runoff. Table 2 shows the value of the support practice factor according to the cultivating 

methods and slope. The P value ranges from 0 to 1 where 0 represents a very good manmade 

erosion resistance facility and 1 represents no manmade erosion resistance facility. Table 2 

provides reference values for the P factor, but other sources can be used as desired. 

 

Table 2. Support practice factor P according to the types of cultivation and slope. Source: 

(Parveen and Kumar, 2012) 

Slope (%) Contouring Strip Cropping Terracing 

0.0 - 7.0 0.55 0.27 0.10 

7.0 - 11.3 0.60 0.30 0.12 
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11.3 - 17.6 0.80 0.40 0.16 

17.6 - 26.8 0.90 0.45 0.18 

>26.8 1.00 0.50 0.20 

 Topographic Factor (LS) 

LS_USLE is the topographic factor that accounts for the effect of topography on erosion. The 

two parameters that constitute the topographic factor are slope gradient and slope length 

factor. The slope- and slope length factors are estimated in WEP using the equations of (Van 

der Knijff et al., 1999): 

 

LS = 44.6 * (sin β) ^ 1.3 

 

where: 

β is the average slope (degrees) 

 

 

3 Tutorial 

Note: 

For this module, you will need to have completed the WEAP Tutorial modules (“WEAP in 

One Hour, Basic Tools, Scenarios, and Hydrology) or have a fair knowledge of WEAP (data 

structure, key assumptions, expression builder, creating scenarios). To begin this tutorial 

on WEAP Erosion Plugin (WEP), go to the Main Menu of WEAP, select “Revert to Version” 

and choose the version named “Answer key for ‘Hydrology’ module.” 

 Open the WEAP tutorial and Revert to Version 

After opening WEAP select:   

 

> Area > Open > ”Tutorial” 

 

Revert to the version “Answer key for ‘Hydrology’ module”: 

 

> Area > Revert to Version > “Answer key for ‘Hydrology’ 

module” 

 

The Schematic View should look like below: 
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 Import the Plugin 

The WEAP Erosion Plugin (WEP) can be imported into the WEAP area. Note that for each 

new WEAP Area, the Plugin has to be imported if erosion should be calculated. 

> Advanced > Plugins > Download 

 

 

 

 

To check whether importing has been successful the new tab Erosion under Data > 

Catchment should appear: 
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 Add the appropriate erosion data 

The specific soil and land data to calculate the erosion rate should be entered in WEAP. In 

this tutorial, the erosion of the three land covers in the Agriculture Catchment will be assessed: 

 

> Data View > Agriculture Catchment > Erosion > Soil Particle 

Diameter 

 

 



12 

 

Enter the following data for the three land covers in the Agriculture Catchment: 

 Soil Particle 

Diameter 

(mm) 

Slope 

(degrees) 

Rain 

Intensity 

(hr per day) 

C USLE 

(-) 

P USLE 

(-) 

Irrigated 0.002 2 4 0.34 0.8 

Forest 0.002 5 4 0.01 0.8 

Grasslands 0.002 10 4 0.04 0.8 

 

Data as shown above are derived using guidelines as presented in the previous Chapter. It is 

assumed that soils (clay) and climate are similar for the three land covers. Differences are: 

• Irrigated areas are located on flat land (slope 2 degrees), sensitive to erosion 

(C_USLE) and conservation practice is low (P_USLE). 

• Forest areas are located on reasonable flat land (slope of 5 degrees), have high 

vegetation coverage (C_USLE) and conservation practice is low (P_USLE). 

• Grass areas are located on undulating land (slope of 10 degrees), reasonably 

covered (C_USLE) and conservation practices are low (P_USLE). 

 

NOTE: Slope should be inserted under Land Use for Current Account (2000). When 

using Automatic Catchment Delineation mode slope is filled in automatically. 

 

 

 

 Look at the results 

Results for Erosion are located in the “Catchment” category in the primary variable pull-down 

menu. 

 

> Result View > Catchments > Erosion per Hectare 
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 Exploring erosion reduction options 

Results show that for this case erosion of the irrigated area is quite high with over 2 tons ha-1 

y-1. Also for the grassland erosion is quite high with about 1.4 ton ha-1 y-1. Some options that 

might be interesting to explore further: 

• At present, climate conditions are considered to be constant for each year. What 

would happen with erosion if more extreme rainfall is happening? 

• Surface runoff is quite high. With different land management soil parameters (e.g. 

Runoff Resistance Factor and Root Zone Conductivity) might change. What is the 

impact on erosion? 

• Introducing conservation practice methods (e.g. contouring, vegetation strips, 

terracing) can be entered by changing the P_USLE. What is the erosion reduction 

that can be achieved? 

• Erosion in the forest area is relatively low (0.03 ton ha-1 y-1). What would be the impact 

of forest degradation (C_USLE will increase) on erosion? 

 

 

  



14 

Annual erosion for the three land covers in tonnes per hectare: 

 

 

 

Monthly erosion for the three land covers in tonnes per hectare: 
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